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Welcome to NESCafe 
 
NESCafe is distributed under the GNU General Public License. A copy of this license agreement 
has been included with this distribution of NESCafe. If you have a question or wish to give me 
any feedback on the NESCafe Nintendo emulator then please do not hesitate to contact me via 
email (my address is above) as your comments and suggestions are always welcome. More 
information on NESCafe can also be found on the NESCafe website (address shown above). 
 
 
Introduction 
 
Welcome to the NESCafe Nintendo Emulator for Java. In a nutshell, the NESCafe emulator allows 
you to play your old 8-bit Nintendo Entertainment System (NES) games on your computer by 
emulating the original hardware of the NES and tricking the games into thinking that they are 
running on the original machine. To play one of your old Nintendo games all what you need is 
NESCafe and a copy of the game in NES format (these can be obtained from the Internet). 
 
NESCafe was the first Java-based emulator for the Nintendo with sound support and the only one 
to offer such a high level of compatibility with the original hardware, by correctly emulating the 
micro-processors and additional controllers. I started work on NESCafe in May 2000 for my final 
year Computer Science project. Since the first release back in 2001, I have been continually 
working on and improving NESCafe during my spare time (not that I get a lot of this). NESCafe is 
now a stable and powerful emulator that can be run from websites or as a standalone application 
from your desktop and runs the vast majority of published Nintendo games. 
 
Since the very first release NESCafe has always been an Open Source project and it will always 
remain so. Keeping NESCafe Open Source has enabled the project to go from strength to 
strength thanks to the helpful feedback and suggestions that I have received from the public 
over the years. This is something that I am very grateful for and I hope that you will all continue 
to push and improve NESCafe further by adding more hardware support, or use the information 
from this project to build bigger and better Java emulators for the legendary 8-bit console. 
 
 
Thanks for downloading NESCafe! 
David de Niese 
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Distributions 
 
The NESCafe Nintendo emulator is available in three different distribution packages. NESCafe is 
available as a compiled application (Binary Distribution), as a compiled Applet for your web-site 
(Applet Distribution) or as source code (Source Distribution). There are also some additional 
Special Editions releases of NESCafe, such as the Punch-Out Special Edition that are available 
from the NESCafe web-site. The following table lists the different NESCafe emulator distributions 
that are available and what kind of person might be interested in downloading each one. 
 
 

Distribution Person 

Binary 

 

[most people] 

The majority of people will want the binary version of NESCafe. 
This version contains everything (apart from the Nintendo games) 
that you will require to get the full version of NESCafe running.  

Applet 

 

[web site developers] 

Anyone wishing to host NESCafe on their own web-site and allow 
their visitors to play Nintendo games online will want to download 
the Applet version of NESCafe (again, no games are included). 

Source Code [hard-core techie’s] 

People that want to understand more about NESCafe, or people 
looking to improve NESCafe, will want to download this distribution. 
This version contains all the Java source code for the emulator. 
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Requirements 
 
Depending on the version of NESCafe that you download (Binary, Applet or Source Code), you 
will need to meet the following software and hardware requirements to use NESCafe. You should 
ensure that these requirements are met prior to installing and using NESCafe from your PC. 
 
 
Binary Distribution 
 

Category Requirement 

Operating System An Operating System is run when you turn on 
your computer and allows you to launch other 
applications. NESCafe supports all the major 
Microsoft and Linux Operating Systems. 
 

   Microsoft Windows XP  
   Microsoft Windows 2000 
   Microsoft Windows ME 

   Red Hat Linux 9.0 
   Suse Linux 9.2 
 

Java Virtual Machine Runtime A Java Virtual Machine allows you to play Java 
applications on your computer. Any of the 
following two Java Virtual Machine Runtimes 
are supported by the NESCafe emulator: 
 

   Sun Java Virtual Machine 1.4.2 
   IBM Java Virtual Machine 1.3.0 (fastest) 
 

WinZip  WinZip is a shareware application that can be 
used to uncompress files from compressed Zip 
files. NESCafe is provided as a Zip file so that 
the distribution can remain small. The user will 
need to uncompress the distribution file and 
extract the files from within. I recommend 
using WinZip to perform this function. 
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Applet Distribution 
 

Category Requirement 

Operating System If you are hosting the Applet from your website 
then you will need to ensure that the Web 
Server is running one of the Operating Systems 
listed below. If you are planning to only run 
the Applet locally then please refer to the 
above requirements for the Binary distribution. 
 

   Microsoft Windows Server 2003 
   Microsoft Windows XP 
   Microsoft Windows Server 2000 
   Microsoft Windows 2000 

   Any mainstream Linux distribution 
 

Java Virtual Machine Runtime There is no requirement for a Java Virtual 
Machine to be installed on the Web Server 
because the Applet code will not be executed 
on the Web Server, instead the Applet will run 
on the remote computer that is connected. 
Therefore, you should ensure that your visitors 
have a Java Virtual Machine installed prior to 
being presented with the NESCafe Applet. 

HTTP Web Server An HTTP Web Server is a software program 
that allows your computer to serve web page 
requests from remote computers. Any of the 
following HTTP Web Servers are supported: 
 

   Microsoft IIS Web Server 5.0 
   Apache 2.0.52 (or higher) 
 

WinZip  WinZip is a shareware application that can be 
used to uncompress files from compressed Zip 
files. NESCafe is provided as a Zip file so that 
the distribution can remain small. The user will 
need to uncompress the distribution file and 
extract the files from within. I recommend 
using WinZip to perform this function. 
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Source Code Distribution 
 

Category Requirement 

Operating System An Operating System is run when you turn on 
your computer and allows you to launch other 
applications. NESCafe supports all the major 
Microsoft and Linux Operating Systems. 
 

   Microsoft Windows XP  
   Microsoft Windows 2000 
   Microsoft Windows ME 

   Red Hat Linux 9.0 
   Suse Linux 9.2 
 

Java Software Development Kit A Java SDK contains the Java Virtual Machine 
runtime environment, plus the tools that you 
will need to develop and compile NESCafe. The 
suggested Java SDK is shown below: 
 

   Sun Java Development Kit 1.4.2 
 

Java Pre-Processor (SJPP) The Java Pre-Processor was used during the 
development of NESCafe to minimise the 
amount of redundant code contained with each 
distribution. For example, pre-processor 
directives were given to ensure that the weight 
of the GUI code from the Binary distribution 
would not be included in the stream-lined 
Applet distribution. The pre-processor used 
from the Simple Java Pre-Processor. 

WinZip  WinZip is a shareware application that can be 
used to uncompress files from compressed Zip 
files. NESCafe is provided as a Zip file so that 
the distribution can remain small. The user will 
need to uncompress the distribution file and 
extract the files from within. I recommend 
using WinZip to perform this function. 
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Linked Websites 
 

Application Website 

Apache HTTP Web Server http://httpd.apache.org/  

Microsoft IIS Web Server http://www.microsoft.com/iis/  

Microsoft Windows http://www.microsoft.com  

NESCafe Website http://www.davieboy.net/nescafe/  

Red Hat Linux http://www.redhat.com  

Simple Java Pre-Processor https://sjpp.dev.java.net/  

Sun Java Virtual Machine and SDK http://java.sun.com  

Suse Linux http://www.suse.com  

WinZip http://www.winzip.com  

 
 

Installing NESCafe 
 
Depending on the version of NESCafe that you downloaded (Binary, Applet or Source Code) and 
the Operating System that you are using, you will need to install NESCafe using one of the 
following different approaches. It is assumed that the reader is proficient in using the Operating 
System of their choice before continuing, and that they are familiar with concepts such as 
directories (folders for Windows users), installing applications and running applications. 
 
 
Binary Distribution 
 

1 Check the requirements for the Binary Distribution and ensure that they are met. 

2 Unzip the distribution files (NESCafexxxbin.zip) to a directory (folder) on your computer. 

3 Microsoft Windows: 

   Go to the folder that you uncompressed NESCafe to and run NESCafe.bat 
 

UNIX or Linux: 

   Change to the directory that you uncompressed NESCafe to and type the following: 

   java –jar nescafe056.zip  

4 NESCafe should now be running on your computer. 
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Applet Distribution 
 

1 Check the requirements for the Applet Distribution and ensure that they are met. 

2 Unzip the distribution files (NESCafexxxapp.zip) to a directory on your Web Server. 

3 Navigate with a Web Browser to the URL corresponding to where you installed NESCafe. 

For example, if you are running Microsoft IIS Web Server and you unzipped 
NESCafe to C:\inetpub\wwwroot\nescafe on your local machine then you should 
navigate to http://localhost/nescafe/NESCafe.html to run the NESCafe emulator. 

4 You should now see NESCafe running from your Web Server with the default NES ROM. 
Please see the Applet Configuration section on how to configure the runtime settings. 

 
 

NESCafe Applet Configuration 
 
The settings for the NESCafe Applet are all contained within the NESCafe.html file. The following 
code listing shows all the possible settings that the Applet supports and the table that follows 
below shows which settings are optional and what their default values are: 
 
Example Applet Code Tag 
 

<applet code = NESCafeApplet archive ="NESCafe056.jar" 
   width =256 height = 240> 
 
   <param name=ROMFILE value="roms/nintendogame.nes"> 
   <param name=LIGHTGUN   value="false"> 
   <param name=SOUND  value="true"> 
   <param name=LOADSTATE  value="savestates/mysavedstate.nes"> 
 
</applet> 

 
 
Parameter Settings Explained 
 

Tag Meaning Optional Default 

Width The width in pixels of the displayed Applet.  

Increasing this value will increase the displayed 
width of NESCafe, but will slow NESCafe down. 
This setting should be at least 256 to ensure 
that the entire Nintendo screen is visible. It 
should be noted that when both the width and 
height are increased beyond 300 pixels then the 
NESCafe screen will be magnified and centred. 

No 256 
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Tag Meaning Optional Default 

Height The height in pixels of the displayed Applet. 

Increasing this value will increase the displayed 
height of NESCafe, but will slow NESCafe down. 
This setting should be at least 240 to ensure 
that the entire Nintendo screen is visible. It 
should be noted that when both the width and 
height are increased beyond 300 pixels then the 
NESCafe screen will be magnified and centred. 

No 240+ 

ROMFILE The location of the Nintendo ROM file. 

When the NESCafe Applet starts up it will 
attempt to load and run whichever ROM file is 
specified by this tag. If no Nintendo ROM file is 
provided then the default nescafe.nes file will be 
loaded instead (from inside the JAR file).  

If you know that your installation of NESCafe 
will only be used to run one particular ROM 
image then it may be worthwhile storing it in 
the Applet JAR file by overwriting the existing 
nescafe.nes file. This will improve the download 
time of NESCafe since the JAR will contain all 
the files required to run that installation. 

Yes nescafe.nes 

LIGHTGUN Whether or not the Light Gun is enabled. 

This tag should be set to True for all the games 
that require Light Gun (Zapper) support (for 
example, games such as Duck Hunt).  

Yes False 

SOUND Whether or not Sound should be emulated. 

This tag should be set to True for all games that 
you want NESCafe to emulate the sound for. 

Java requires a lot of resource to emulate 
Sound and if this is not available (if you are not 
getting 60 frames per second) then the sound 
can appear crackled and distorted. Therefore, 
this setting allows your low-end visitors to not 
suffer the poor sound quality and frees up some 
cycles to speed up the main game emulation. 

Yes False 

LOADSTATE A Saved State to Load at Start Up. 

This tag points at a NESCafe saved state file to 
load at Start Up. The saved state file must 
belong to the ROMFILE that is currently being 
used and must have been generated by the 
current version of the NESCafe emulator. 

Yes None 

 



 The NESCafe Emulator for Java 
 

Page 9 of 17 
 

Using NESCafe 
 
Binary Distribution 
 
When running NESCafe in standard mode (from the Binary Distribution) the menu system allows 
you to perform most of the functions that you will require. The File menu allows you to load and 
close ROM files, as well as commit and rollback to saved states. The NES menu allows you to 
pause and reset the Nintendo hardware, the View menu controls the display options and the 
Sound menu manages the audio options. The following diagrams take you through the menus: 
 

 

Loading ROM Files 

The file menu can be used for loading and closing Nintendo 
ROM files. When you start NESCafe click on the Load Rom 
menu item and a dialogue box will be presented allowing 
you to select the ROM image that you want to load. Shortly 
afterwards the game will start running in the main window. 

 

Committing States and Rolling Back 

You can also use this menu to commit the state of NESCafe 
and then load it back again at a later stage. For example, if 
you are just about to battle Bowser then you could hit 
Commit State (keyboard shortcut C). If you were then to 
die just hit Rollback to State (keyboard shortcut L) and you 
would be right back where you were ready for a rematch! 

 

 

Pausing NESCafe 

Some games never allow you to pause them exactly where 
you want to (for example, you cannot pause Punch-Out in 
the middle of a boxing round). Well now, by selecting 
Pause ROM from the NES menu (keyboard shortcut P) you 
can pause the actual emulation of the Nintendo game 
instead, allowing all games to be paused upon request. 

 

Light Gun (Zapper) Support 

If the game you are playing requires a Light Gun (such as 
Duck Hunt) then simply click on the Enable Light Gun menu 
item to have the gun plugged into Joy pad Port 2. You can 
now use the mouse to aim and left mouse button to fire. 

 

Game Genie Support 

NESCafe supports Game Genie codes. Click on Enter Game 
Genie Code and then supply a code for the game that you 
are currently playing. There are hundreds of known Game 
Genie codes for almost all Nintendo games on the Internet. 
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 Nintendo 6502 Debugging Engine 

NESCafe also includes a Nintendo 6502 Debugging Engine. 
This allows you to see what is really going on inside the 
Nintendo game that you are playing – but be warned, you 
will require a good working knowledge of 6502 Assembler. 

 

 

The View Menu 

The View Menu can be used to show the current frame rate 
that you are getting (which should be around 60 frames 
per second). If you are experiencing slow performance 
then it might be interesting to see exactly how slow the 
emulation is running. Chances are that your hardware may 
need to be improved to get the full 60 frames per second. 

You can also use the View menu to hide the two layers that 
the NES display uses (the Background and Sprites layers). 
Try playing Mario without the Background layer on to see 
exactly how well you know the game, or hide each layer in 
turn to see how a particular Nintendo screen is composed. 

 

 

 

The Sound Menu 

The Sound menu can be used to enable or disable the 
Sound whilst playing NESCafe. If the Sound menu is greyed 
out then you may not have any sound card installed on 
your computer or you may be running an older version of 
the Java Virtual Machine (one that doesn’t support sound). 

You can also use this menu to enable or disable specific 
sound channels (to see which channels a particular 
Nintendo theme makes use of) or to records the sound 
output of a game to a Windows WAV file for later listening. 

 

 

The Online Menu 

The Online menu allows you to download ROM images 
from the NESCafe website directly into your version of 
NESCafe. Simply click on Download ROM and a dialogue 
will appear that shows all the games that are currently 
available online. Unfortunately, the list is usually small or 
not available because of outstanding copyright protection 
issues surrounding the provision of Nintendo ROM files. 
However, the functionality has been provided in-case these 
rules change or copyright is abandoned for specific games. 
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Applet Distribution 
 

 

The Applet version runs from within a Web 
Browser. The screen-shot on the left shows 
NESCafe running from within Microsoft 
Internet Explorer, hosted from a Microsoft 
IIS HTTP Web Server. The main game 
(Super Mario Bros) appears in the central 
window and the bottom panel shows the 
controls that are available to Applet users. 

The look and feel of the NESCafe interface 
is predominately from the NESCafe.html file 
(the actual NESCafe Java Applet only 
presents the game window). If you intend 
hosting NESCafe from your website then 
please feel free to change the NESCafe.html 
page to your suiting and brand, however I 
would appreciate it if you could retain a link 
to the NESCafe homepage with a comment 
such as ‘Powered by NESCafe 0.56’. 

 

Playing Games (the Controls) 
 
The following tables show the keys that can be used whilst Nintendo games are running in the 
standard and Applet versions of the NESCafe emulator. The Applet user interface alludes to most 
of the available key controls, but there are a couple of additional keys that are also available. 
 
Controls for Joy Pad 1 
 
Nintendo Function NESCafe Standalone NESCafe Applet

Start button Enter Enter

Select button Spacebar Spacebar

A button X X

B button Z Z

Up button Up arrow Up arrow

Down button Down arrow Down arrow

Left button Left arrow Left arrow

Right button Right arrow Right arrow
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Controls for Joy Pad 2 (requires Light Gun to be Enabled) 
 

Nintendo Function NESCafe Standalone NESCafe Applet

Aim Light Gun (Zapper) Move mouse Move mouse

Fire Light Gun (Zapper) Click left Mouse Button Click Left Mouse Button

 
 
Adjustment Controls 
 

Nintendo Function NESCafe Standalone NESCafe Applet

Frame Skip Key 1 to 8 (1 being no skip) Key 1 to 8 (1 being no skip)

Pause Emulation P P

Reset the Game R R

Sound Toggle  S S (must be enabled in tag)

Commit State of Emulator C not available

Rollback to Saved State L L

Toggle Monochrome/Colour B B

Tint Adjust Down - -

Tint Adjust Up + +

Hue Adjust Down 9 9

Hue Adjust Up 0 0

 
 
NESCafe Debug Engine Controls 
 
Nintendo Function NESCafe Standalone NESCafe Applet

Toggle Debug Mode F5 not available

Step by Instruction F6 (when in debug mode) not available

Step by 20 Instructions F7 (when in debug mode) not available

Step to next Event F8 (when in debug mode) not available
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NESCafe Online Features 
 
Legal Notice (read before proceeding) 
 
NESCafe allows you to download ROMs directly from the NESCafe Website, however you should 
only download Nintendo games that you legally own the original cartridge for, otherwise you are 
acting illegally. The author (David de Niese) accepts no liability or responsibility from your use of 
NESCafe or from you downloading a Nintendo ROM that you are not legally entitled to download. 
 
 
Configuring NESCafe to Work with your Proxy Server 
 
If you use a Proxy Server to connect to the Internet, you will need to configure NESCafe to use it 
by going to the Online menu and selecting 'Configure Internet Connection'. In the dialog that is 
presented, you need to specify the name of your proxy server and the port number that you 
communicate with your proxy server on. If your proxy server requires authentication you can also 
specify a username and password. Unfortunately, NESCafe will not support proxy scripts so 
please input only the IP address or name of your proxy server on the network.  
 
 
Configuring NESCafe to Work with your Firewall 
 
If you use a Firewall, such as Norton or Black ICE, and you want to be able to use NESCafe for 
online features then you will need to allow NESCafe to use port 80 (HTTP). Instructions on how 
to do this will be included with the documentation for your firewall product. Please be aware that 
NESCafe does not attempt to broadcast any personal information from your computer (you can 
confirm this by viewing the source code that is available from the NESCafe website). However, 
you should be reminded that because NESCafe is an Open Source product someone could have 
changed it to act maliciously, therefore please ensure that the version of NESCafe you are using 
came from the NESCafe site and that it only attempts to access www.davieboy.net on port 80. 
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Hardware Supported 
 
The following list of hardware is emulated by NESCafe: 
 

• The n6502 Micro-processor 
• The Nintendo Picture Processing Unit (PPU) 
• 5 Sound Channels (2 Square, Triangle, Noise and DMC) 
• NES Joy-pad and Light Gun 

 
 
Additional supported features: 
 

• Allows users to Save and Load the State of the NES 
• Emulates and interprets Game Genie Codes 
• Provides a built-in Nintendo 6502 Debugger 
• Provides a built-in ROM Download Client 

 
 
The following Memory Management Controllers (MMC’s) are supported: 
 

001: Nintendo MMC1 
002: PROM Switch (UNROM) 
003: VROM Switch (CNROM) 
004: Nintendo MMC3 
005: Nintendo MMC5 
006: Konami FFE F4xxx 
007: Rare AOROM 
008: Konami FFE F3xxx 
009: Nintendo MMC2 
010: Nintendo MMC4 
011: Color Dreams 
015: 100-in-1 
017: Konami FFE F8xxx 
018: Jaleco SS8806 
021: Konami VRC4 2A 
022: Konami VRC4 type 1B 
023: Konami VRC2 type B 
032: Irem G-101 
033: Taito TC0190 TC0350 
034: Nina-1 
040: SMB2J 
041: Caltron 6-in-1 
046: Rumble Station 
047: NES-QJ 
048: Taito TC190V 
050: SMB2J 
057: 54-in-1 
058: 68-in-1 
060: 65-in-1 
062: Mapper 62 
 

064: Tengen Rambo-1 
065: Irem H-3001 
066: Bandai 74161/32 
067: Sunsoft Mapper 3 
068: Sunsoft Mapper 4 
070: 74161/32 
071: Camerica Mapper 
072: Jaleco Early Mapper 0 
073: Konami VRC3 
075: Jaleco/Konami VRC1 
076: Namco 109 
077: Irem Early Mapper 0 
078: Jaleco 74161/32 
079: Nina-3 (AVE) 
080: Taito X-005 
082: Taito C075 
086: Jaleco Early Mapper 2 
087: Konami 74161/32 
088: Namco 118 
089: Sunsoft Early Mapper 
091: PC-HK-SF3 
092: Jaleco Early Mapper 1 
093: Sunsoft 74161/32 
094: Capcom 74161/32 
097: Irem 74161/32 
099: VS Unisystem 
101: Jaleco 74161/32 
105: Nintendo World Championship 
113: PC-Sachen/Hacker 
117: PC-Future 
 

119: TQ-ROM 
122: Sunsoft 74161/32 
140: Mapper 140 
151: VS Unisystem (Konami) 
180: Nichibutsu 
181: Hacker International Type 2 
182: PC-SuperDonkeyKong 
183: Gimmick (Bootleg) 
184: Sunsoft 74161/32 
185: CHR-ROM Disable Protect 
189: Street Fighter 2 Yoko 
222: Mapper 222 
225: 72-in-1 
226: 76-in-1 
227: 1200-in-1 
228: Action 52 
229: 31-in-1 
231: 20-in-1 
232: Quattro Games 
233: 42-in-1 
236: 800-in-1 
240: Gen Ke Le Zhuan 
242: Wai Xing Zhan Shi 
243: PC-Sachen/Hacker 
244: Mapper 244 
245: Yong Zhe Dou E Long 
246: Phone Serm Berm 
248: Bao Qing Tian 
251: Mapper 251 
255: 110-in-1 
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NESCafe History 
 
NESCafe 0.56 
 

• V flag in P register not be set correctly on addition and subtraction (cheers Qian Wenjie) 
• JMP ($aaaa) not correctly implemented and fixed (cheers Qian Wenjie) 
• Improved GUI, more consistent between Applet and Standalone versions. 
• Sound toggle bug fixed when pressing S in standalone didn’t enable channel selection. 
• Microsoft JVM 5.0 works in Applet Mode now 

 
 
NESCafe 0.55 
 

• 77 new Mappers supported (including fixes to existing Mappers) 
• Better Implementation of handling UP+DOWN or LEFT+RIGHT (SmashManiac) 
• Embedded NESCafe ROM into the main distribution 
• Game Images are stored as DDNB files, which will provide metadata for their content 
• Fix to PPU: No longer reset PPU address mode during Vertical Blank. 
• Fix to PPU: Reading from VRAM in ppuRead correctly mirrors the Palette memory. 
• Remove Processor Interface (speed up)  
• Added code to correct incorrectly dumped ROM images (partial implementation). 
• Added code to change clock cycles for specific games (such as Battle Toads and SMB3). 
• Larger screen sizes are now supported in Applet mode. 
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NESCafe 0.54 
 

• DMC Sound Support 
• Applet now reads GIF files from within JAR file 
• Can now Load a Saved State from Applet Mode 
• Improvements to the SoundInterface (a bit smoother) 
• Fixed bug with JoyPad - UP+DOWN or LEFT+RIGHT were not cancelling (SmashManiac) 
• Fixed bug in N6502 where Inactive Display was sleeping for 200ms (SmashManiac) 

 
NESCafe 0.53 
 

• Applet is now compiled with 1.1 Class Structure so works with Microsoft JVM Plugin. 
• NESCafe Client now works with Corporate Firewalls and Proxy Servers.  

 
 
NESCafe 0.52 
 

• Fixed major bug with PPU clearing Sprite0 Hit on Reg 2002 Read. 
• Added an inbuilt debugging engine (press F5 to enter). 
• Added ROM Download Engine (download ROMs directly from Internet into NESCafe). 
• NESCafe display is now resizable (need fast machine!).  
• Support for GZIP and ZIP compressed files. 
• Support for the Nintendo Zapper (Light Gun) added. 
• GUI improvements and Checkbox Menu Items. 
• Battery Backed Memory fully implemented - Save RAM. 
• Dropped CPU Cycles per scan line down to 116 
• Colour Emphasis working in PPU register 2001 
• Fixed bug with PPU where rendering was not happening if Screen was Off. 
• Fixed Sprite 0 Collision Detection, works inline with Damian Yerrick's Test. 
• Fixed Nintendo MMC1 and MMC3. 
• Added Mapper Konami FFE F4xxx and FFE F3xxx  
• Added Mapper Color Dreams 
• Added Mapper 100-in-1 and 1200-in-1 
• Wrote and provided NESCafe ROM Image (Demo NES ROM) 

 
 
NESCafe 0.50 
 

• Applet Mode has been re-introduced and improved.  
• The GUI has had some internal improvements.  

 
 
NESCafe 0.43 
 

• Debug Mode has been removed from N6502 processor.  
• Undocumented Opcodes Processing now an option. (Jeremy Chadwick suggested) 
• MMC2 Mapper now perfect - will run Punchout without glitches.  
• Removed NET and Applet support because it wasn't working correctly.  
• Picture Processing Unit now perfect - better support for all games.  
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NESCafe 0.42 
 

• Incorrect addressing mode used with RRA $aaaa,Y instruction. (Rob Gonzalez) 
• SAX instruction doesn't set the Carry bit. (Rob Gonzalez) 
• LSR instruction is not clearing the SIGN bit. (Rob Gonzalez) 
• LoadSaveRam method causes problems when run as Applet. (Tyler Gibson) 

 


